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Lampiran A 

Hasil Rancangan Hardware 
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Lampiran B 

Proses Uji Karakteristik Alat Ukur 
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Lampiran C 

Proses Pengambilan Data Suhu Induced Draft Fan 
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Lampiran D 

Program Arduino IDE 

#include <ESP8266WiFi.h> 

#include <WiFiUdp.h> 

#ifndef STASSID 

#define STASSID "Mimi Peri" 

#define STAPSK  "1234567890" 

#endif 

int remotePort = 2000; //clien Device port 

unsigned int localPort = 8888;// Server local port  

IPAddress remoteIp(192,168,110,85);//Server Computer IP 

char packetBuffer[UDP_TX_PACKET_MAX_SIZE + 1]; //buffer to 

hold incoming packet, 

WiFiUDP Udp; 

#define RTD A0  

int RTDValue=0; 

int temp=0; 

float suhu=0.00; 

void setup() { 

  Serial.begin(115200); 

  WiFi.mode(WIFI_STA); 

  WiFi.begin(STASSID, STAPSK); 

  while (WiFi.status() != WL_CONNECTED) { 

    Serial.print('.'); 

    delay(500); 

  } 

  Serial.print("Connected! IP address: "); 

  Serial.println(WiFi.localIP()); 

  Serial.printf("UDP server on port %d\n", localPort); 

  Udp.begin(localPort); 

} 

void loop() { 

  RTDValue=analogRead(RTD); 
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  Serial.println(RTDValue); 

  //4mA 1V 205 0 C 

  //20 mA 5V 1023 200 C 

  temp=map(RTDValue,205,1023,0,200); 

  suhu=temp; 

  Serial.print(suhu);Serial.println("C");  

  Udp.beginPacket(remoteIp,remotePort); 

  Udp.print(suhu); 

  Udp.print(" "); 

  Udp.endPacket(); 

  delay(1000); 

} 
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Lampiran E 

Program Labview 
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Lampiran F 

Data Uji Karakteristik Alat Ukur Suhu 

• Suhu 50 ℃ 
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• Suhu 80 ℃ 
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• Suhu 100 ℃ 
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• Suhu 120 ℃ 
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• Suhu 150 ℃ 
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•  Suhu 180 ℃ 
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Lampiran G 

Data Suhu Induced Draft Fan berdasarkan Jangkauan Wifi 

• Jarak 10 meter  
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• Jarak 20 meter  
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• Jarak 30 meter  
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• Jarak 40 meter  
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• Jarak 50 meter  
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• Jarak 80 meter  
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The ESP8266 is the name of a micro controller designed by Espressif Systems. The 
ESP8266 itself is a self-contained WiFi networking solution offering as a bridge from 
existing micro controller to WiFi and is also capable of running self-contained applications. 

This module comes with a built in USB connector and a rich assortment of pin-outs. With a 
micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any 
trouble, just like Arduino. It is also immediately breadboard friendly. 

  

ESP8266 NodeMCU WiFi Devkit 
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1. Specification: 
• Voltage:3.3V. 
• Wi-Fi Direct (P2P), soft-AP. 
• Current consumption: 10uA~170mA. 
• Flash memory attachable: 16MB max (512K normal). 
• Integrated TCP/IP protocol stack. 
• Processor: Tensilica L106 32-bit. 
• Processor speed: 80~160MHz. 
• RAM: 32K + 80K. 
• GPIOs: 17 (multiplexed with other functions). 
• Analog to Digital: 1 input with 1024 step resolution. 
• +19.5dBm output power in 802.11b mode 
• 802.11 support: b/g/n. 
• Maximum concurrent TCP connections: 5. 

2. Pin Definition: 

 

3. Using Arduino IDE 
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The most basic way to use the ESP8266 module is to use serial commands, as the chip is basically a WiFi/Serial 
transceiver. However, this is not convenient. What we recommend is using the very cool Arduino ESP8266 project, 
which is a modified version of the Arduino IDE that you need to install on your computer. This makes it very 
convenient to use the ESP8266 chip as we will be using the well-known Arduino IDE. Following the below step to 
install ESP8266 library to work in Arduino IDE environment.  

3.1 Install the Arduino IDE 1.6.4 or greater 
Download Arduino IDE from Arduino.cc (1.6.4 or greater) - don't use 1.6.2 or lower version! You can use your 
existing IDE if you have already installed it. 

You can also try downloading the ready-to-go package from the ESP8266-Arduino project, if the proxy is giving you 
problems. 

3.2 Install the ESP8266 Board Package 
Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs 
field in the Arduino v1.6.4+ preferences. 

 

Click ‘File’ -> ‘Preferences’ to access this panel. 

Next, use the Board manager to install the ESP8266 package. 

https://www.arduino.cc/en/Main/Software�
https://www.arduino.cc/en/Main/Software�
https://github.com/esp8266/Arduino�
https://github.com/esp8266/Arduino�


5 www.handsontec.com 
 

 

Click ‘Tools’ -> ‘Board:’ -> ‘Board Manager…’ to access this panel. 

Scroll down to ‘ esp8266 by ESP8266 Community ’ and click “Install” button to install the ESP8266 library package. 
Once installation completed, close and re-open Arduino IDE for ESP8266 library to take effect. 

3.3 Setup ESP8266 Support 
When you've restarted Arduino IDE, select ‘Generic ESP8266 Module’ from the ‘Tools’ -> ‘Board:’ dropdown menu. 

 

 
Select 80 MHz as the CPU frequency (you can try 160 MHz overclock later) 
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Select ‘115200’ baud upload speed is a good place to start - later on you can try higher speeds but 115200 is a good 
safe place to start. 

 
 
 
Go to your Windows ‘Device Manager’ to find out which Com Port ‘USB-Serial CH340’ is assigned to. Select the 
matching COM/serial port for your CH340 USB-Serial interface. 
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Find out which Com Port is assign for CH340 Select the correct Com Port as indicated on ‘Device Manager” 
 
Note: if this is your first time using CH340 “ USB-to-Serial ” interface, please install the driver first before proceed 
the above Com Port setting. The CH340 driver can be download from the below site: 
 

3.4 Blink Test 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers 
 

 

We'll begin with the simple blink test. 

Enter this into the sketch window (and save since you'll have to). Connect  a LED as shown in Figure3-1. 

 

void setup() { 
  pinMode(5, OUTPUT);   // GPIO05, Digital Pin D1 
} 
 
void loop() { 
  digitalWrite(5, HIGH); 
  delay(900); 
  digitalWrite(5, LOW); 
  delay(500); 
} 
 

 
 

Now you'll need to put the board into bootload mode. You'll have to do this before each upload. There is no timeout 
for bootload mode, so you don't have to rush! 
 

• Hold down the ‘Flash’ button. 
• While holding down ‘ Flash’, press the ‘RST’ button. 
• Release ‘RST’, then release ‘Flash’ 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers�
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Figure 3.2: Uploading the sketch to ESP8266 NodeMCU module. 

The sketch will start immediately - you'll see the LED blinking. Hooray! 

 

3.5 Connecting via WiFi 
 

OK once you've got the LED blinking, let’s go straight to the fun part, connecting to a webserver. Create a new sketch 
with this code: 

Don’t forget to update: 

const char* ssid     = "yourssid"; 

const char* password = "yourpassword"; 

to your WiFi access point and password, then upload the same way: get into bootload mode, then upload code via 
IDE. 

 

/* 
 *  Simple HTTP get webclient test 
 */ 
 

#include <ESP8266WiFi.h> 
 
const char* ssid     = "handson";     // key in your own SSID 
const char* password = "abc1234";     // key in your own WiFi access point 
password 
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const char* host = "www.handsontec.com"; 
 
void setup() { 
  Serial.begin(115200); 
  delay(100); 
 
  // We start by connecting to a WiFi network 
 
  Serial.println(); 
  Serial.println(); 
  Serial.print("Connecting to "); 
  Serial.println(ssid); 
   
  WiFi.begin(ssid, password); 
   
  while (WiFi.status() != WL_CONNECTED) { 
    delay(500); 
    Serial.print("."); 
  } 
 
  Serial.println(""); 
  Serial.println("WiFi connected");   
  Serial.println("IP address: "); 
  Serial.println(WiFi.localIP()); 
} 
 
int value = 0; 
 
void loop() { 
  delay(5000); 
  ++value; 
 
  Serial.print("connecting to "); 
  Serial.println(host); 
   
  // Use WiFiClient class to create TCP connections 
  WiFiClient client; 
  const int httpPort = 80; 
  if (!client.connect(host, httpPort)) { 
    Serial.println("connection failed"); 
    return; 
  } 
   
  // We now create a URI for the request 
  String url = "/projects/index.html"; 
  Serial.print("Requesting URL: "); 
  Serial.println(url); 
   
  // This will send the request to the server 
  client.print(String("GET ") + url + " HTTP/1.1\r\n" + 
               "Host: " + host + "\r\n" +  
               "Connection: close\r\n\r\n"); 
  delay(500); 
   
  // Read all the lines of the reply from server and print them to Serial 
  while(client.available()){ 
    String line = client.readStringUntil('\r'); 
    Serial.print(line); 
  } 
   
  Serial.println(); 
  Serial.println("closing connection"); 
} 
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Open up the IDE serial console at 115200 baud to see the connection and webpage printout! 
 

 

 

That's it, pretty easy right ! This section is just to get you started and test out your module. 

 

 

 

 

 

 



 

 

 

Wiring Configuration. 

 

Two Wire 
When accuracy is not critical, a two-wire RTD is the least expensive; 
offering. Using lead wires to place any distance between a two wire RTD and a 
receiving device will further compromise its accuracy. The potential for poor 
accuracy from a two-wire RTD stems from its inability to compensate for lead 
length, resistance that changes the ohm value of the original signal. A two-wire 
RTD should be used only in applications where the receiving device connects 
directly to the sensor 

Three Wire RTD 
Three-wire RTD's compensate for resistance resulting from length differences by 
adding a third lead to the RTD. To accomplish this requires that the wires match 
exactly. Any difference in resistance between the lead wires will cause an 
imbalance, which will compromise the accuracy of the RTD. Lead length 
variance, work hardening or corrosion, and manufacturing irregularities are errors 
to avoid. Quality manufacturing is critical to insure balance of all three leads. 

Four Wire RTD 
Errors caused by resistance imbalance between leads are cancelled out in a four-
wire RTD circuit. Four-wire RTD's are used where superior accuracy is critical or 
if the sensor is installed far from the receiving device. In a four-wire RTD one 
pair of wires carries the current through the RTD the other pair senses the voltage 
across the RTD. 2- and three-wire RTD's require heavier lead wire because 
thicker wire, by creating less resistance to the measured signal, reduces 
measurement distortion. Therefore lighter gauge wire, less expensive, may be 
used in four-wire RTD applications. RTD's are limited to temperatures of 1200 ° 
F and because of the construction of the sensing element, RTD's do not do well in 
high-vibration and severe mechanical shock environments. When selecting a 
temperature sensor for an application you should consult your temperature sensor 
manufacturer for recommendations. 

 

 



Accuracy, Stability, and Repeatability. 

Tolerance/Accuracy is calculated as:
Class B change in t=+/- (0.3+0.005|t|) 
Class A change in t=+/- (0.15+0.002|t|) 

1/3 Class B change in t=+/- 1/3 x (0.3+0.005|t|) 
1/5 Class B change in t=+/- 1/5 x (0.3+0.005|t|) 
1/10 Class B change in t=+/- 1/10 x (0.3+0.005|t|) 

|t| = absolute temperature in °C. Where elements have a resistance of n x 
100 Ohms then the basic values and tolerances also have to be multiplied 

by n 

These three terms are often confused, but it is important to understand the difference. 

• Accuracy. IEC standard 751 sets two tolerance classes for the accuracy of RTDs: Class A and Class B:  

Class A: Δt = ±(0.15 + 0.002 • | t | )  

  

Class B: Δt = ±(0.30 + 0.005 • | t | ) 

where: 

| t | = absolute value of temperature in °C 

Class A applies to temperatures from –200°C to 
650°C, and only for RTDs with three- or four-wire 

configurations. Class B covers the entire range from 
–200°C to 850°C. 

• Stability. This is the sensor's ability to 
maintain a consistent output when a 
constant input is applied. Physical or 

chemical changes can cause calibration 
drift. The material that the platinum is 

adhered to, whether wound on a mandrel or on a substrate, can expand and contract, straining the wire. 
Drift rates conservatively specified by manufacturers are typically 0.05°C/yr.  

• Repeatability. Repeatability is the sensor's ability to give the same output or reading under repeated 
identical conditions.  

Absolute accuracy is not necessary in most applications. The focus should be on the stability and repeatability of 
the sensor. If an RTD in a 100.00°C bath consistently reads 100.06°C, the electronics can easily compensate for 

this error. The stability of RTDs is exceptional, with most experiencing drift rates of 0.05°C over a five-year 
period. 

Response Time. 
Response time varies according to the application. It is the sensor's ability to react to a change in temperature, 

and depends on the sensor's thermal mass and proximity to the material being tested. For instance, an RTD 
sensor in a thermowell will react more slowly than the same sensor immersed directly into a process. RTD 
specifications will list the sensor's time constant, which is the time it takes for an RTD to respond to a step 

change in temperature and come to 63% of its final equilibrium value. Response times are calculated in water 
flowing at 0.2 m/s and in air flowing at 1 m/s. This gives a useful comparison of RTD sensor configurations. 

 

Figure 3. Lead wires have resistance that is a function 
of the material used, wire size, and lead length. This 

resistance can add to the measured RTD resistance, and 
improper wire compensation can result in significant 
errors. The common configurations of RTDs are two 

(A), three (B), or four wires (C). 
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SBWZ Serial Temperature Transmitter

Introduction
 SBWR Serial thermocouple temperature transmitter and

SBWZ serial RTD temperature transmitter is a spot mounted

temperature transmission unit in DDZ-S serial instruments

and meters .

 It adopts the two-wire transmission method (the power input

and the signal output are two communal conductors).

 There is a linear 4~20m current signal between the output

and the measured temperatures.

 The transmitter may be installed inside the terminal box of

the thermocouple and the thermal resistance to form an

integral structure,and also independently mounted in the

instrument panel as a change-over unit.

 Application: To be a new generation thermometric meter, it is

widely applied in the industrial and scientific research fields

such as petroleum, chemicals, textile, metallurgy,

electro-machinery, electric force, aviation, food, processing,

pharmaceutical engineering, etc for the purpose of

automated temperature testing, transmitting and controlling.

Features:
 Can be directly installed in the sensor

terminal box
 Accurate signal can be transmitted far

way(Max 1000M)
 High accuracy with long-term stability,

maintenance-free

Technical Characteristics

Model SBWZ

Input Siginal
Thermocouple: K E J B S T N
RTD: PT100 CU50 CU100

Output Siginal 4 ～ 20mADC

Working Voltage Related voltage: 24VDC ± 10% (Ordinary12V~35V ，Intelligent 12V~45V）

Intrinsic Error
0.5%FS,

0.2%FS (Intelligent )
Mode Of
Connection

Two-wire system, three-wire system, four-wire system

Allowed Load
Resistance

500Ω(24VDC)

Ultimate Load
Resistance

R(max)=50(Vmin-12)
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Measuring
Range

-200～1800℃

Ratio of
Environment

Effects
δ≤0.05%/°C

Work
Environment

Temperature: -25-+80°C(Ordinary)
-25-+70°C(Digit Display)
-25-+75°C(Intelligent)

Relative Humidity:5%-95%

Mechanical Vibration f≤50Hz, swing≤0.15mm

Non-corrosive gas or similar environment

Pipe Spec
Stainless steel pipe diameter:Φ 4 、Φ 6 、Φ 8 、Φ 10 、Φ 12 、Φ 14 、Φ 16
Pipe Length: 30mm ～ 100mm ～ 200mm, or customized length available

Case Blue Φ36 × 16 mm

Connection



FEATURES & BENEFITS
• Overload & Overvoltage Protection
• <1% Noise and Ripple
• 85-260 VAC, 47-63 Hz Input Voltage

© December, 2013

SMALL SIZE, EFFICIENT
Wavelength offers the PWRPAK-24V low noise switched 
power supply for the QCL Series Laser Drivers.  

One of the most important components affecting noise 
performance is the power supply used to power the QCL 
driver.  Wavelength has extensively tested the TDK/ Lambda 
switching power supply, and recommends this power supply 
for most QCL applications.  A linear supply will offer lower 
noise, but a much larger size and lower effi ciency.

e Pb

RoHS C
om
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ORDERING INFORMATION
PART NO DESCRIPTION
PWRPAK-24V 24 V Switched Power Supply

WCB312 QCL Power Supply Wiring Kit

WCB313 QCL 3-Pin Power Cable

PAGECONTENTS
QUICK CONNECT GUIDE 2
PERFORMANCE SPECIFICATIONS 3
MECHANICAL SPECIFICATIONS 5
CERTIFICATION AND WARRANTY 6

USED WITH
• QCL Series Quantum Cascade Laser Drivers

PWRPAK 24 V 
Switched Mode Power Supply

DATASHEET AND OPERATING GUIDE

406-587-4910
www.teamWavelength.com
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PWRPAK 24 V SWITCHED POWER SUPPLY

WIRING POWER SUPPLY TO QCL DRIVER 

Follow these instructions to wire the power supplies using 
the WCB312 Wiring Kit and WCB313 Power Cable.  Refer 
to Figure 2.
• AC Safety Ground #1: 24 AWG green wire, 10” with ring 

lugs on each end; connect to the Frame Ground terminals 
on the power supplies.

• AC Safety Ground #2: 24 AWG green wire; 10” with 
one ring lug; connect to the Frame Ground terminal on 
one power supply; connect the other end to AC Chassis 
Ground.

• Common Ground: 24 AWG black wire; 10” with ring lugs 
on each end; connect between V– of Positive Supply and 
V+ of Negative Supply.

• Use the remaining ring lugs to connect the power supply 
cable (WCB313) to the V+, Power Ground, and V– 
terminals of the power supplies.

Figure 2 indicates a 150 kΩ resistor connecting the 
power supplies to ground; this resistor is necessary if the 
electronics ground is tied to earth ground at some point 
within your system, such as at a DAQ card, computer, or 
USB cable connection.

This resistor provides a lossy connection from system 
ground to earth ground, and will prevent the ground potential 
of isolated power supplies from drifting. Note that if this 
resistor is used the remote POWER and ENABLE inputs 
must be optically isolated in order to function properly.

If you are unsure whether to include this resistor in your 
system, contact Wavelength Electronics for technical 
assistance.

QUICK CONNECT GUIDE

!
TO DETERMINE IF THE PWRPAK-24V POWER SUPPLY IS 
APPROPRIATE FOR YOUR APPLICATION, IT IS IMPERATIVE THAT 
YOU VERIFY THE UNIT WILL BE OPERATING WITHIN THE 
INTERNAL HEAT DISSIPATION SAFE OPERATING AREA (SOA).

Visit the Wavelength Electronics website for the most 
accurate, up-to-date, and easy to use SOA calculator.

The SOA calculator for Laser Diode Drivers is at this page:
http://www.teamwavelength.com/support/calculator/soa/soald.php,
then choose the appropriate QCL driver.

WIRING THE PWRPAK-24V

Figure 1 illustrates the power supply connections for single 
supply operation:
+V — positive output terminal
-V — negative output terminal
FG — frame ground
L — live line input terminal (fuse in line)
N — neutral input terminal
Output voltage adjustment
Output monitoring LED

Output voltage adjustment

Output monitoring LED

+V

-V

FG

L

N

Figure 1.    Power Supply Wiring Connections

Figure 2 shows an example of a correctly connected 
grounded load.

AC(L) AC(N)FG-V+V AC(L) AC(N)FG-V+V

POSITIVE SUPPLY NEGATIVE SUPPLY

V- (Pin J4-2)
V+ (Pin J4-3)

Ground
(Pin J4-1)

Ground Interconnect

Neg-to-Pos Interconnect

Ground Wire

Twisted Pair 

Chassis
Ground

150k

Earth
Ground

1

1

1 1

2

2

2

1. Cable included as part of the WCB312 Power Supply Wiring Kit
2. Included with the QCL Driver. (WCB313)

Connect to AC Mains; refer to performance 
specifications for input voltage requirements.

Figure 2.    Power Supply Wiring Diagram, Dual Supply 
Operation



© 2013 www.teamWavelength.com 3

PWRPAK 24 V SWITCHED POWER SUPPLY

PERFORMANCE SPECIFICATIONS

PARAMETER DESCRIPTION PARAMETER VALUE NOTES
INPUT
Input Voltage 85 - 265 VAC

Frequency 47 - 63 Hz

OUTPUT
Output Power Maximum 52.8 W

Output Voltage 24 V Output voltage is within ±20% of nominal output voltage:

Output Current 2.2 A

Hold Up Time 20 ms

Line Regulation 96 mV

Load Regulation 192 mV

Ripple & Noise 150 mV 100 MHz bandwidth

Overvoltage Protection 30 - 34.8 V

Inverter shutdown, manual reset.  When OVP triggers, the output 
will be shutdown.  Remove the input and re-connect to reset 
power.  The OVP setting is fi xed, not user adjustable.  In the 
case of an inductive load, use a decoupling diode at the output 
terminal.

Overload Protection, hiccup trip & auto restart >104% Constant current limiting and hiccup with automatic recovery 
when overload condition clears.

Temperature Coeffi cient < 0.02% / °C

GENERAL
Effi ciency 82 / 84 % 100 / 200 VAC input.  Power Thermistor Protection

Operating Temperature (1) -10 to + 71 °C See derating chart above 50°C

EMC
Emissions, FCC B  
                  EN55011 / EN55022 Yes

SAFETY
UL/cUL, CB, CE Mark Approved Yes

Weight 280 g

Size 1.46 x 3.23 x 6.3 inches

(1)  Derating information can be found in Table 1 on page 4.  



Carbon Film Leader Resistor - Resistor 
 
 
 
 
■Marking & Resistance Tolerance 
 

 
 
 
 
 
  

1st ban  2nd band  3rd band    4th band 
1st digit 2nd digit  Multiplier   Tolerance 

 
 

 
 
 
 

±5% E-24 1.0 1.1 1.2 1.3 1.5 1.6 1.8 2.0 2.2 2.4 2.7 3.0 3.3 3.6 3.9 4.3 4.7 5.1 5.6 6.2 6.8 7.5 8.2 9.1
 
 
 

Cold Digit Multiplier Tolerance 

- - - - Without 
- 10-2  - - Silver 
- 10-1 ±5.0% J Gold 
0 100 - - Black 
1 101 - - Brown 
2 102 - - Red 
3 103 - - Orange 
4 104 - - Yellow 
5 105 - - Green 
6 106 - - Blue 
7 107 - - Violet 
8 108 - - Grey 
9 109 - - White 

 



ISO 9001 Manufacturer

t e m p e r a t u r e

Specification Sheet, SS-ETC

» Temperature ranges
ETC-125 A    -10 to 125°C / 14 to 257°F
ETC-400 A    28 to 400°C / 82 to 752°F 
ETC-400 R    28 to 400°C / 82 to 752°F

» Fast calibration saves money
Heats up as quickly as 100°C / 212°F per 
minute and stabilizes in just 3 minutes.
Completes a 2-point test in less than 10 
minutes

» Extreme flexibility
The small size makes it perfect to store in a 
tool box and to check temperature sensors 
that are difficult to access

» Fully-featured despite the small size
The multi-information display shows actual 
and set temperatures, a stability indicator, 
and a stability countdown timer

» Timesaving features
Fast one-key-one-function access to set the 
temperature and the auto-stepping function

» Documentation made easy
RS232 communication interface and  
JOFRACAL calibration software are part of 
the ready-to-use standard delivery

» Easy IR calibration
Standard delivery of the ETC-400 R
includes JOFRA IR-LAB software enabling 
the user to calibrate IR thermometers with a 
fixed emission factor setting

» Complete marine program
Part of a complete program of marine 
approved temperature, pressure and signal 
calibrators; including temperature sensors

Heats up by up to 100°C / 212°F per minute and completes a full dual-
point test in less than 10 minutes, including stability time; timesavings at 
your fingertips! The ETC- series is designed for field testing of tempera-
ture measurement devices. 

The small size and light weight make it a perfect instrument to verify sen-
sors in difficult to reach places. 

All JOFRA ETC units have many of the same useful and timesaving fea-
tures offered in the more advanced JOFRA dry-block series.

Designed for people who perform tests and verifications of temperature 
sensing devices in the field. This instrument is ideal when time is a criti-
cal factor and the highest accuracy is not a critical factor. 

Reduced size and weight are important considerations because the unit 
is able to fit into a tool box or instrument carrying case and can be used 
for sensors that are difficult to access.

One-key-one-function user interface provides immediate access to set-
ting the temperature and the auto-step timesaving function. There is no 
need for manipulation of sophisticated menus. 

The Stability indicator provides audible and visual prompts when the 
temperature is stable. This function also includes a 3 minute countdown 
before the stable condition.

Stainless steel and rubber side panels make the instrument suitable for 
many years of faithful duty in an industrial environment.

Easy Temperature Calibrator

ETC-series



ETC-400 R for infrared thermometers
The ETC-400 R is designed for optimum speed in connec-
tion with calibration of infrared thermometers. The 36 mm 
target provides the optimum size for reliable calibration 
of infrared thermometers in the process industry as it is 
designed for high accuracy and long-term stability while 
maintaining speed.

With regard to the coating of the target it has been espe-
cially designed for space technology applications, which 
secure long time performance under high temperature 
influence. In combination with the shape of the target it 
ensures the emissivity of 0.96. 

If higher accuracy is required, and for recalibration, a 3 
mm external JOFRA STS reference probe can be placed 
under the surface of the target. 

Super fast heating - ETC-400 A dry-block
The ETC-400 A is designed for optimum speed. The heat-
ing block is built around a highly efficient heating element. 
The insertion holes for the temperature device under 
test are located around this element. To reduce mass 
and increase effectiveness, there is no removable inser-
tion tube; the holes are drilled directly into the block. The 
minimal mass offers an extremely fast heating and cooling 
time. The different layouts also make it possible to use an 
external JOFRA STS reference probe during the calibra-
tion. Choose the combination of holes that best suits your 
needs from our various design combinations. 

If your application requires a dry-block that can handle 
large sensors or more than one sensor at a time, we offer 
several other JOFRA dry-block calibrators that can meet 
your needs.

Cooling and heating - ETC-125 A dry-block
The ETC-125 A is a simple yet effective tool for verify-
ing temperature instruments that also require references 
below ambient temperatures: e.g. air-conditioning and 
cold counters. The predrilled holes allow the use of an 
insertion tube in the largest bore. This increases the flex-
ibility to match many sensor-under-test sizes.

Easy-to-use, intuitive operation
All instrument controls are accessed directly from the front 
panel. The main functions on the ETC series are designed 
with one-key-one-function logic. This means that there are 
no difficult multiple keystrokes to remember to access pri-
mary functions. The easy-to-read, backlit display features 
dedicated icons, which help in identifying instrument con-
ditions and operational steps.

Set temperature
The ’’Up’’ and ’’Down’’ arrow keys allow the user to set 
the exact temperature desired with a resolution of 0.1°C 
or °F.

Instrument setups
The ETC-series stores the complete instrument setup, 
including: engineering units, stability criteria, resolution, 
auto-step settings, and maximum temperature.

Stability indicator
The bold checkmark on the display indicates that the 
calibrator has reached the desired set temperature and is 
stable. The operator may change the stability criteria and 
establish a greater level of confidence in the calibration 
results as desired. A convenient countdown timer is acti-
vated three minutes before the unit reaches stability. This 
prompts you to be prepared to record results.
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JOFRA IR-LAB software for the ETC-400 R
As an extra feature the ETC-400 R will be delivered with 
a small mathematical program, which will constitute a 
powerful tool together with the calibrator. The program 
enables you to calculate at which temperatures you need 
to calibrate, if your IR thermometer is either locked to a 
fixed emission factor or if you just want to calibrate your 
thermometer at a certain emission factor. The program fa-
cilitates the whole issue of correcting settings of emission 
factors and temperatures.

The calibration surface of the JOFRA ETC-400 R IR 
calibrator has an emission factor of 0,96. If your IR-ther-
mometer is using a different emission factor than 0.96, 
the result will be a faulty temperature reading on your IR 
thermometer. However if your IR thermometer is using an 
emission factor of 0.95 or 0.98 – a helpfull diagram is part 
of the standard delivery.

Example: Your thermometer is locked to an emission 
factor of 0,98 and you have set the JOFRA ETC-400 
R to 300°C. The diagram indicates that 3,9°C must be 
subtracted from the calibrator temperature, to obtain the 
“true” IR thermometer reading (296,1°C).

If you are working with IR thermometers where the emis-
sion factor is different than 0.95, 0.96 or 0.98, or other 
parameters differ from “standard”, use the PC program 
JOFRA IR-Lab. The JOFRA IR-Lab program allows you to 
type in various emission factors, in order to get a “true” 
temperature readout on your thermometer or the other 
way around - what is the true surface temperature of the 
calibrator. But the IR-Lab will do more than that; it allows 
you to calculate “true” temperatures in simulated sur-
roundings that approximate your actual test environments.

�

�

Calibration of up to 24 sensors with JOFRA ASM
Using the JOFRA ETC series together with the ASM 
Advanced Signal Multi-scanner offers a great time-saving 
automatic solution to calibrate multiple temperature sen-
sors at the same time. 

The ASM series is an eight channel scanner controlled by 
JOFRACAL software on a PC. Up to 3 ASM units can be 
stacked to calibrate up to 24 sensors at the same time. 
It can handle signals from 2-, 3- and 4 wire RTD’s, TC’s, 
transmitters, thermisters, temperature switches and volt-
age.

Auto-stepping
This feature saves time. The operator may stay in the con-
trol room, or another remote location, monitoring the out-
put from the sensor-under-test while the ETC- series cali-
brator  is placed in the process and automatically changes 
the temperature using a programmed step value and rate. 
Up to 9 different temperature steps may be programmed, 
including the hold time for each step. This feature is also 
ideal for burning-in new sensors prior to installation; this 
minimizes initial drift and allows for initial testing. It is also 
useful for testing temperature data loggers.

Maximum temperature
From the setup menu, you can select a lower maximum tem-
perature limit for the calibrator. This function prevents damage 
to the sensor-under-test caused by the application of exces-
sive temperatures. 

Re-calibration/adjustments made easy
The ETC- series has a very easy and straightforward pro-
cedure for re-calibration/adjustment. There is no need for 
a screwdriver or PC software. The only thing you need is 
a reliable reference thermometer. Place the probe in the 
calibrator and follow the instructions on the display. 

Use the ETC calibrator with JOFRACAL calibration software
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122832 	 Cleaning Brushes - 4 mm - Package of 3 pcs
60F174 	 Cleaning Brushes - 6 mm - Package of 3 pcs
122822 	 Cleaning Brushes - 8 mm - Package of 3 pcs
125002 	 Edgeport Converter with 4 pcs of RS232 ports
124094 	 Carrying Case for ETC Series

1)  The ETC-400 R is delivered with a carrying case as standard  
because it is important to keep dust away from the surface of the 
target on the ETC-400 R.  The reason being that a clean surface is 
important to keep the emissivity and thereby the accuracy. The car-
rying case is optional for ETC-400 A and ETC-125 A. 

STANDARD DELIVERY

•	 JOFRA ETC dry-block calibrator

•	 Traceable calibration certificate - temperature 		
performance

•	 JOFRACAL calibration software

•	 User and reference manual

•	 Mains power cable

•	 Shoulder strap

•	 RS232 cable

•	 1 × predrilled insertion tube (ETC-125 A only)

•	 Tool for insertion tubes (ETC-125 A only)

•	 Carrying case (ETC-400 R only) 1)

•	 JOFRA IR-LAB calibration software (ETC-400 R only)

•	 Emissivity table (ETC-400 R only)

ACCESSORIES

Carrying case (Optional for ETC-125/400 A) - 
124094
The optional protective carrying case ensures safe trans-
portation and storage of the instrument and all associated 
equipment.

JOFRACAL CALIBRATION SOFTWARE
JOFRACAL calibration software ensures easy calibration 
of RTD´s, thermocouples, transmitters, thermoswithes, 
pressure gauges and pressure switches. JOFRACAL can 
be used with JOFRA DPC-500, APC, CPC and IPI pres-
sure calibrators, all JOFRA temperature calibrators, as well 
as JOFRA AMC900, ASC300 multi signal calibrator and 
ASM-800 signal multi scanner. 

JOFRACAL calibration software may also be used for 
manual calibrations, as it can be set up to accept manual 
entry of calibration data together with other liquid baths, 
ice points or dry-block heat sources. 

The calibration data collected may be stored on a PC for 
later recall or analysis. The calibrator stores the calibration 
procedure and may be taken out to the process site with-
out using a personal computer.  

Once all calibrations are completed, the data may be 
uploaded to the JOFRACAL calibration software for post-
processing and printing of certificates. The calibration data 
collected may be stored on the personal computer for 
later recall or analysis.

The JOFRACAL temperature 
calibration software may be 
donwloaded at www.jofra.com

JOFRACAL software 
Minimum hardware requirements for JOFRACAL calibra-
tion software.

•	 INTELTM  486 processor

•	 (PENTIUMTM 800 MHz recommended)

•	 32 MB RAM (64 MB recommended)

•	 80 MB free disk space on hard disk prior to installation

•	 Standard VGA (800 x 600, 16 colors) compatible screen

•	 (1024 x 786, 256 colors recommended)

•	 CD-ROM drive for installation of the program

•	 1 free RS232 serial port
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Temperature range @ ambient temp. 23°C / 73°F

ETC-125 A 
Maximum.........................................................125°C / 257°F
Minimum @ ambient temp.   0°C / 32°F............ -18°C / -0°F
Minimum @ ambient temp. 23°C / 73°F............. -10°C /14°F
Minimum @ ambient temp. 40°C / 104°F............ 6°C / 43°F
ETC-400 A.......................28 to 400°C / 82 to 752°F@ 23°C 
ETC-400 R.......................28 to 400°C / 82 to 752°F@ 23°C

Resolution (user-selectable)

Selectable ..............................................................1º or 0.1º

Heating time

ETC-125 A
-10 to 23°C / 14 to 73°F..........................................3 minutes
23 to 100°C / 73 to 212°F.....................................11 minutes
100 to 125°C / 212 to 257°F...................................7 minutes

ETC-400 A / R
28 to 200°C / 82 to 392°F......................................2 minutes
200 to 400°C / 392 to 752°F..................................3 minutes

Cooling time

ETC-125 A
125 to 100°C / 257 to 212°F.................................. 1   minute
100 to 0°C / 212 to 32°F.......................................17 minutes
0 to -10°C / 32 to 14°F..........................................14 minutes

ETC-400 A
400 to 200°C / 752 to 392°F..................................6 minutes
200 to 50°C / 392 to 122°F...................................15 minutes

ETC-400 R
400 to 200°C / 752 to 392°F..................................9 minutes
200 to 50°C / 392 to 122°F...................................24 minutes

Stability

ETC-125 A ...............................................±0.05°C / +0.09°F 
ETC-400 A .............................................. ±0.15°C / +0.27°F  
ETC-400 R ................................................±0.3°C / ±0.54°F 

Measured after the stability indicator has been on for 10 minutes. 
Measuring time is 30 minutes.

Time to stability  (approximate)

All models ..............................................................3 minutes

Accuracy 

ETC-125 A.................................................+0.5°C / +0.9°F 1)

ETC-400 A................................................+0.5°C / +0.9°F 1) 
ETC-400 R............................................... ±0.5°C / ±0.9°F 2) 
ETC-400 R incl. emissivity 
.................................... ±0.4% rdg ±1°C / ±0.4% rdg. ±1.8°F

1) 	 Specification when using the internal reference. (Load 4 mm 	
	 OD reference probe in the center of the insert). 
2) 	 Specification when using the internal reference. (Load 3 mm 	
	 OD reference probe).

FUNCTIONAL SPECIFICATIONS

Immersion depth

ETC-125 A (insulation included)................. . 110 mm / 4.3 in
ETC-400 A....................................................105 mm / 4.1 in

Mains specifications

Voltage ETC-125 A..........Multivoltage 115VAC and 230VAC
.........................................115V(90-132) and 230V(180-264)
Voltage ETC-400 A/R........ 115V(90-127) or 230V(180-254)
Frequency ETC-125 A...........................................47 - 63 Hz 
Frequency ETC-400 A/R......................................45 - 65 Hz
Power consumption (max.) ETC-125 A........................75 VA
Power consumption (max.) ETC-400 A/R..................350 W

KEY FEATURES

Auto stepping

Programmable..................................................Up to 9 steps
Dwell time on each step................................ Programmable

Multi-information display

Stability indicator........................................Clear checkmark
Countdown timer before stable..............................3 minutes
Temperature........................SET and READ simultaneously
Alphanumeric messages................................................. Yes
Calibration status icons................................................... Yes

Training mode (heating/cooling block disabled)

Simulation of all functions............................................... Yes
Simulating heating and cooling...... Approx. 100° per minute

Service facilities

Adjustment of the unit from the keypad.......................... Yes
Self explaining guide in display..........................................Yes
Other information:............................. Display serial number,  
.................. software revision level, and last calibration date 

Setup facilities

Stability criteria: .......... Extra time before ’’stable indication’’  
................................................................................ is shown
Display resolution.............................................. .1° or 1°C/°F
Temperature units.................................................... °C or °F
Slope rate.................................................. 0.1 to 9.9°/minute
Maximum temperature......................Any value within range
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INSERTS FOR ETC SERIES

Metric Multi-hole Type 21
(ETC-400 A)

4

4

2

3
6

Type 51 
ETC-400 R 

36 mm (1.4 in) target

Imperial Type 02 
(ETC-125 A)

5/32 1/4

Metric Type 01 
(ETC-125 A)

4 6

12,5

1/4

3/16

1/16

1/8

3/8

Imperial Multi-hole Type 12
(ETC-400 A)

Imperial Multi-hole Type 11
(ETC-400 A)

1/4
3/16

1/16

1/8

5/32

PHYSICAL SPECIFICATIONS

Instrument dimensions

ETC-125 A, ETC-400 A and ETC-400 R
L × W × H:.................172 × 72 × 182 mm / 6.8 × 2.8 × 7.2 in

Instrument weight

ETC-125 A........................................................1.8 kg / 3.9 lb
ETC-400 A.......................................................1.6 kg / 3.5 lb 
ETC-400 R....................................................... 1.7 kg / 3.7 lb

Shipping (including shipping cargo box)

ETC-125 A:.......................................................3.0 kg / 6.6 lb
ETC-400 A:......................................................2.8 kg / 6.2 lb 
ETC-400 R.......................................................4.5 kg / 9.9 lb

Size, L × W × H:  
ETC-125 A / 400 A:...............................................................  
............................. 345 × 235 × 135 mm / 13.6 × 9.3 × 5.3 in 
ETC-400 R...........425 x 320 x 165 mm / 16.7 x 12.5 x 6.5 in

Miscellaneous

Serial data interface .................................................. RS232
Operating temperature......................0 to 40°C / 32 to 104°F
Storage temperature.......................-20 to 50oC / -4 to 122oF
Humidity ...........................................................0 to 90% RH
Protection class ............................................................ IP-10
DNV Marine Approval, Certificate no.......................A-10384

Instruments

Type ETC-125 A ETC-400 A

5-pack, undrilled inserts 01 + 02 123939 N/A

Predrilled insert, metric 8 mm 01 123938 N/A

Predrilled insert, imperial 3/8 in 02 124045 N/A

1/5

3/8 mm
insert

8 mm
insert

NOTE: All ETC400 calibrators are with fixed inserts. They 
can NOT  be changed.
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Order no.			  Description	
					     Base model number
STS103			   Pt100 reference probe, 0°C to 400°C

					     Diameter of the probe
		    B			  Overall diameter 3 mm

					     Shape and length
			   150	 Straight probe, 150 mm (5.9 in) 

					     Cable length and termination 
			        A	 Cable 0.5 m (1.6 ft.) + LEMO connector
 			        B	 Cable 2 m (6.6 ft.) + LEMO connector	
			        C	 Cable 2 m (6.6 ft.) + Banana plug connectors

					     Calibration certificate 
				      H	Accredited calibration certificate (standard)
				      F	NPL traceable calibration certificate
				      G	NIST traceable calibration certificate
				      I	 No certificate - Annealed only  
					     (Useless without calibration certificate /  
					     co-efficients)
				      S	Special calibration certificate

STS103B150AH 	Sample order number
					     Reference Pt100 150 mm., cable length  
					     0.5 m (1.6 ft.) with LEMO termination and  
					     accredited certificate

It is not easy to make a good quality reference probe. The 
main requirement of a reference probe is stability. This 
means minimal drift as a function of operating time at the 
actual temperature. The less the probe drifts, the lower the 
measurement uncertainty.

Especially for the ETC-400 R calibrator JOFRA has 
designed a special 3 mm STS reference sensor, the STS-
103 B. The sensor can be used as a reference sensor 
when a higher accuracy is required or for recalibration of 
the ETC-400 R. Due to the small immersion depth require-
ment of the sensor it can be placed under the surface of 
the target.

Temperature range

All probes...................................-50 to 400°C / -58 to 752°F

Accuracy

Hysteresis1) @0°C / 32°F...............................0.01°C / 0.02°F 
Long term stability 2) @0°C / 32°F...... typ. 0.014°C / 0.025°F 
Repeatability 1)......................................... 0.005°C / 0.009°F
Note 1:	When used in the range -45 to 400°C / -49 to 752°F. 
Note 2: When exposed to 400°C / 752°F for 100 h. Stability will 
depend on actual use of the sensor.

Sensing element

Type..............................................................................Pt100
Nominal resistance@0°C / 32°F..................................100 Ω
Length ............................................................. 6 mm / 0.2 in
Temperature coefficient..........................α100=0.00385 1/°C

Minimum immersion depth

STS-103 B (3 mm / 0.12 in): ...........................40 mm / 1.6 in

Self-heating effect

0.06°C/mW / 0.108°F/mW

Response time 

τ0.5 (50%)...............................................................5 seconds
τ0.9 (90%).............................................................15 seconds

Liquid in motion v=0.4m/s.

Electrical connections

Cable..............................................................4 wire + shield
Connection................................................ LEMO goldplated

Insulation resistance

@ 23°C / 73°F...................................................... 100 Gohm
@ 400°C / 752°F.................................................... 70 Mohm

Outer tube

Inconel 600

Operating conditions

(Probe, connection, and cable) ...............Max. 70°C / 158°F
Storage temperature ......................-20 to 70oC / -4 to 158oF
Humidity ...........................................................0 to 90% RH
Protection class (connectors).................... DIN 40050 IP-50

Shipping dimensions - including carrying case

L x W x H............... 750 x 140 x 140 mm / 29.5 x 5.5 x 5.5 in

Shipping weight including packing

STS-103 B...........................................................2 kg / 4.4 lb

SPECIFICATIONS STS-103 B

•	 JOFRA STS-103 B probe

•	 Cable - according to order number

•	 Accredited certificate, points:  
-45, -20, 0, 50, 100, 200, 400°C 

•	 Plastic carrying case with foam insert

•	 User manual

STANDARD DELIVERY

Dimensions
Ref. mm inch

A 150 5.91

B 3 0.12

JOFRA STS-103 B

ORDERING INFORMATION STS-103 B
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Order no.				   Description
						      Base model number
ETC125A				    ETC-125 A, -10 to 125°C / 14 to 257°F
ETC400A				    ETC-400 A, 28 to 400°C / 82 to 752°F
ETC400R				    ETC-400 R, 28 to 400°C / 82 to 752°C

						      Power supply
		      115			  ETC-400 A/R only: 115 VAC, 50/60 Hz
		      230			  ETC-400 A/R only: 230 VAC, 50/60 Hz
		      MUL		  ETC-125 A only: Multi voltage 115 and 230 VAC 

						      Mains power cable type
			       A		  European, 230 V,
			       B		  USA/Canada, 115 V
			       C		  UK, 240 V
			       D		  South Africa, 220 V
			       E		  Italy, 220 V
			       F		  Australia, 240 V
			       G		  Denmark, 230 V
			       H		  Switzerland, 220 V
			        I		  Israel, 230 V

						      Holes for sensor-under-test 
				      01 	 ETC125 A - Metric (12.5 mm, 6 mm, 4 mm, 8 mm)
				      02 	 ETC125 A - Imperial (1/2 in, 3/8 in, 1/4 in, 5/32 in)
				      11 	 ETC400 A - Imperial (1/16 in, 1/8 in, 5/32 in, 3/16 in, 1/4 in)
				      12 	 ETC400 A - Imperial (1/16, 1/8 in, 3/16 in, 1/4 in, 3/8 in)
				      21 	 ETC400 A - Metric (2 mm, 3 mm, 4 mm, 6 mm)
				      51 	 ETC400 R

						      Calibration certificate
					     E	 NPL and NIST traceable calibration certificate  
						      (standard delivery)
	   				    H	 Accredited calibration certificate  
						      (on quotation basis)

						      Options
		    			     C	Carrying case (standard for ETC-400 R)

ETC400A230A21EC	Sample order number
JOFRA ETC-400 A series dry-block, 230 VAC power, European power 
cord, metric drilled multihole block, standard NPL/NIST traceable certifi-
cate and carrying case. 
							     

ORDERING INFORMATION
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AMETEK Test & Calibration Instruments
A business unit of AMETEK Measurement & Calibration 

Technologies Division offering the following industry 
leading brands for test and calibration instrumentation.

JOFRA Calibration Instruments
Temperature Calibrators

Portable dry-block calibrators, precision thermometers 
and liquid baths. Temperature ranges from 

-90°C(-130°F) to 1205°C(2200°F). Temperature sensors 
for industrial and marine use.

Pressure Calibrators
Convenient electronic systems ranging from -25 mbar to 
1000 bar  - fully temperature-compensated for problem-

free and accurate field use.
Signal Instruments

Process signal measurement and simulation for easy 
control loop calibration and measurement tasks.

M&G Pressure Testers & Pumps
Pneumatic floating-ball or hydraulic piston dead weight 
testers with accuracies to 0.015% of reading. Pressure 

generators delivering up to 1,000 bar.

Lloyd Instruments
Materials testing machines and software from Lloyd 

Instruments guarantees expert materials testing 
solutions. The comprehensive program also covers 

Texture Analysers to perform rapid, general food testing 
and detailed texture analysis on a diverse range of foods 

and cosmetics. 

Davenport Polymer Test Equipment 
Allows measurement and characterization of moisture-

sensitive PET polymers and polymer density.

Chatillon Force Measurement
The hand held force gauges and motorized testers 

have earned their reputation for quality, reliability and 
accuracy and they represent the de facto standard for 

force measurement.

Newage Testing Instruments
Hardness testers, durometers, optical systems and 

software for data acquisition and analysis.

Information in this document is subject to change without notice. ©2011, by AMETEK, Inc., www.ametek.com. All rights reserved.

www.jofra.com

UK
AMETEK Calibration Instruments
Tel +44 (0)1243 833 302
jofra@ametek.co.uk

France
AMETEK S.A.S.
Tel +33 (0)1 30 68 89 40
general.lloyd-instruments@ametek.fr 

Germany
AMETEK GmbH
Tel +49 (0)2159 9136 510
info.mct-de@ametek.de

Denmark
AMETEK Denmark
Tel +45 4816 8000
jofra@ametek.com 

USA
AMETEK Mansfield & Green
Tel +1 (800) 527 9999
cal.info@ametek.com

India
AMETEK Instruments India Pvt Ltd.
Tel +91 22 2836 4750
jofra@ametek.com 

Singapore 
AMETEK Singapore Pte Ltd
Tel +65 6484 2388
jofra@ametek.com

China
AMETEK Inc. - Shanghai
Tel +86 21 5868 5111

AMETEK Inc. - Beijing
Tel +86 10 8526 2111

AMETEK Inc. - Guangzhou
Tel +86 20 8363 4768
jofra.sales@ametek.com.cn
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